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Guiding Question
How do ocean currents impact seasonal 
sea surface temperatures?

Project Duration 
Two 45-minute class periods 

Grade Level 
Grades 9-12+ (ages 14-18)

Learning Objectives
Students will be able to: 
• 	describe how technological 

advances have impacted the field of 
oceanography, focusing on the use of 
satellites

•	 observe seasonal changes in sea 
surface temperatures (SSTs) throughout 
the year, identifying months with the 
warmest and coldest coastal SSTs

Subjects
• Earth and Space Science
•	 Physical Geography
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How Warm Is the Ocean?  
Currents and Sea Surface Temperature
  		                           By Steven Moore, Jennifer Vuturo-Brady, and Hedley Bond
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TEACHER INSTRUCTIONS

How do ocean currents  
impact seasonal sea surface 
temperatures?

Activity Overview
In this activity, students will use satellite imagery to learn 
more about ocean circulation and the major currents 
impacting the East and West Coasts of the United States. 
Through this investigation, they will gain a stronger 
understanding of circulation patterns within the ocean 
and the significance of those patterns.

Background Information
Today, Earth’s oceans are studied intensively from afar. 
Technologies such as remote-sensing satellites and 
offshore stationary and drifting buoys collect and transmit 
data via satellite to computers in researchers’ laboratories 
and interested citizens’ homes. Imaging sensors mounted 
on orbiting satellites transmit data that can be used to 
determine sea surface temperatures (SSTs), chlorophyll 
levels, ice coverage, sediment plumes, and other oceanic 
conditions on a global scale. 

Remote sensing is the process of obtaining information 
about an object or phenomenon without actually touching 
it. Although the distance between the object and the 
data-gathering sensor can be large or small, most remote-
sensing equipment is located some distance above the 
surface of Earth. Sensors may be mounted on orbiting 
satellites, airplanes, or raised platforms.

Background Knowledge
Students will be able to make better sense of the data 
analysis if they have a basic understanding of ocean 

currents, latitude, and seasons as key factors influencing 
sea surface temperature.

Connections to National Standards 
NATIONAL GEOGRAPHY STANDARDS
•	 Standard 1: How to use maps and other geographic 

representations, tools, and technologies to acquire, 
process, and report information from a spatial 
perspective

•	 Standard 4: The physical and human characteristics of 
places

•	 Standard 7: The physical processes that shape the 
patterns of Earth’s surfaces

NATIONAL SCIENCE EDUCATION STANDARDS GRADES 9-12 
•	 Energy in the Earth system (D-1)
•	 The origin and evolution of the Earth system (D-3)
•	 Science and technology in local, national, and global 

challenges (F-6)
•	 Environmental quality (F-4)
•	 Abilities of technological design (E-1)
•	 Historical perspectives (G-3)

 
Vocabulary
boundary current, noun—a deep ocean current that 
develops as a result of changes in temperature and 
salinity.
latitude, noun—distance north or south of the Equator, 
measured in degrees.
longitude, noun—distance east or west of the prime 
meridian, measured in degrees.
ocean current, noun—stream of water flowing near the 
ocean’s surface or far below it.
remote sensing, noun—information gathering about the 
Earth’s surface from a distance.
sea surface temperature (SST)—temperature of the water 
film at the sea surface.
sensor, noun—instrument that receives a signal and 
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transmits data about that signal, such as data on light and 
heat.
thermal radiation, noun—electromagnetic radiation 
emitted from a heat or light source as a consequence of 
its temperature.
transmitters, noun—an electronic device which, with the 
aid of an antenna, produces radio waves.

 
Extending the Learning
Have students explore stationary and drifting buoys, which 
float on the ocean surface. Stationary buoys, such as those 
maintained by the National Weather Service (NWS) and 
the National Oceanic and Atmospheric Administration’s 
(NOAA) National Data Buoy Center (NDBC), provide 
real-time information about offshore conditions. A buoy’s 
sensors may measure wind speed, direction and gust, 
barometric pressure, air temperature, SST, wave height, 
and wave periods. While the sensors transmit data 
continuously, public updates are posted hourly on the 
Web. Both current and historical data are available from 
the NDBC website: http://www.ndbc.noaa.gov. 

In the My World project, turn on the All buoys layer. Zoom 
in to a coastline of interest to you. Find the name or Station 
ID of some stationary buoys in your area of interest. 

Turn off the All buoys layer, and turn on the Four Buoys 
layer. Zoom out to show the entire United States and all 
four buoys. Each buoy provides monthly SST data from 
a National Marine Sanctuary. Examine the data and 
compare the SSTs from the four sites.

Researchers also use satellite-tracked buoys to study 
surface currents and local ocean conditions. Each is 
composed of a float and a tail. The float portion contains 
a radio transmitter and a buoy, while the submerged 
tail portion causes the buoy to move with the current. 
The sensors attached to drifting buoys acquire data 
continuously and calculate hourly averages. When a 
satellite passes overhead, roughly every six hours, the data 
sets are transmitted from the drifting buoy to the satellite, 
and from there to a receiving station on Earth. 

Turn on both of the drifting buoy layers, Buoy 41630 and 
Buoy 41631. Examine the data table for Buoy 4130. How 

many records are there? When was this buoy deployed? 
When was it retrieved? Zoom in to view the path of the 
buoy. Identify start and end points by applying a color 
scheme, such as Rainbow 2, to latitude. Choose Edit the 
Appearance Of the Active Layer > Color. Then select Color 
by: LAT > Color Scheme. The different colors applied to 
the buoy positions and the Get Information Tool will help 
you find these points. Measure the net distance (start 
to finish) traveled by Buoy 41630. Measure the actual 
distance traveled by clicking the points in the path of the 
buoy. Determine the net and average actual speed of the 
buoy. How does the SST change along the path of the 
buoy? Repeat the above for Buoy 41631. 

You can search for data close to where you live at the 
National Data Buoy Center: http://www.ndbc.noaa.gov/. 
Download current or archived data for a buoy, create a 
table containing the data, and analyze it. 

Additional Resources
•	 National Geographic Education’s encyclopedia 

entries on remote sensing and more: http://education.
nationalgeographic.com/education/reference-and-news/

•	 NOAA Drifter Data Assembly Center’s information about 
drifting buoys: http://www.aoml.noaa.gov/phod/dac/
dacdata.html and at the NDBC (http://www.ndbc.noaa.
gov/drift.shtml)

•	 POET’s additional SST data for different regions, 
different time periods, and at different scales: http://
poet.jpl.nasa.gov 

•	 Historic information about the HMS Challenger’s 19th 
century study of the world’s oceans:  http://aquarium.
ucsd.edu/Education/Learning_Resources/Challenger/

•	 NOAA’s Ocean Explorer “Mountains in the Sea” 
website, featuring different data collection techniques: 
http://oceanexplorer.noaa.gov/explorations/03mountains/
background/challenger/challenger.html

 



How Warm Is the Ocean? Currents and Sea Surface Temperature •  Teacher Instructions  •  Page 17

TEACHER INSTRUCTIONS

•	 U.S. States—Polygon layer with U.S. state borders 
and demographic data, from ESRI.

•	 Countries—Polygon layer with country boundaries, 
from ESRI.

•	 North American Currents—Lines indicating three 
important ocean currents in North America.

•	 North Atlantic Gyre—Layer showing the North 
Atlantic Gyre.

•	 Sea Surface Temperatures 2007—Monthly MODIS 
data on SST for January 2007 to November 2007 
from http://poet.jpl.nasa.gov/. Data obtained as 
ARC GRID ASCII files for the area 60° N to 5° N 
(latitude) and 144° W to 44° W (longitude). 

Data Dictionary
Additional information about each of the layers used in this project.
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STUDENT INSTRUCTIONS

In this activity, you will use satellite imagery to learn 
more about ocean circulation and the major currents 
impacting the East and West Coasts of the United States. 

This investigation will help you build an understanding of 
circulation patterns within the ocean and the significance 
of those patterns. You will observe seasonal changes in Sea 
Surface Temperatures (SSTs) throughout the year, identifying 
months with the warmest and coldest coastal SSTs.

Use the student answer sheet to record answers for each of question below.

Part I: Exploring Sea Surface Temperature
GETTING STARTED
1.	 Launch My World GIS by double-clicking its icon on the Dock (Mac) or Start List (PC). 

2.	 Navigate to the file, Sea Surface Temperatures 07.m3vz, and choose Open > Project. You can also double-click the project 
name to open the project.

How do ocean currents  
impact seasonal sea surface 
temperatures?

By Steven Moore, Jennifer Vuturo-Brady, and Hedley Bond 
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	 The view in the map window includes North America, Central America, and a satellite image showing the average SST 
in degrees Celsius (°C) for January 2007. Scientists constructed the images used in this section with data obtained 
from a Moderate Resolution Imaging Spectroradiometer (MODIS) sensor mounted on the Terra satellite, operated 
by the National Aeronautics and Space Administration (NASA.) The MODIS sensor measures the amount of thermal 
infrared radiation given off by the surface of the ocean. The image displayed on the map was constructed from data 
obtained at night to avoid misleading values due to the effects of sunlight. Researchers then calculated the sea surface 
temperatures from the infrared data to produce a false-color image. The image is called false-color because the colors 
you see are a representation of wavelengths that are not visible to the human eye. Any gray spots scattered over the 
image represent missing data, mostly from clouds. A spectrum of colors is used in the image to represent different sea 
surface temperatures. 

3.	 Notice that only three layers from the Layer List are visible in the Map window: Countries, U.S. States, and 2007 Sea 
Surface Temps. 

QUESTION 1: Refer to the SST legend below the image. 
a. Which colors represent the warmest waters? 

b. Which colors represent the coldest waters? 

4.	 Use the Get Information tool    to obtain SST and latitude values for selected locations on the Atlantic and Pacific 
coasts in order to compare temperatures. 

	 To use the Get Information tool, make the SST layer active by clicking it. (Note that the active layers have a yellow 
border.) Select the Get Information tool, and then click a location along the coast. A window, Information for layer “2007 
Sea Surface Temps,” will appear with area, latitude, longitude, and temperature for all eleven months of the SST data 
set. If you click the Keep Records in Table check box, all the data records from subsequent queries with the tool on that 
layer will appear as a list in the table. Close the Information window when you are finished. 

	 Latitude tells you how far north or south of the equator you are, while longitude provides the distance east or west of the 
prime meridian (0° longitude.) The prime meridian runs through Greenwich, England.

QUESTION 2: How do water temperatures in the Pacific Ocean compare with those found in the Atlantic Ocean during 2007? 

QUESTION 3: The waters surrounding the island of Newfoundland, which lies off the eastern coast of Canada at a latitude 
of 50° N and a longitude of 55° W, appear deep blue in the SST images for the first few months of 2007. What does this 
mean? (Hint: Check the temperature with the Get Information tool. A temperature of 99° indicates that you’ve selected a 
point with missing data for that month.)

5.	 Examine the seasonal changes in SSTs along the Atlantic coast of the United States during 2007 to see when the 
warmest and coldest temperatures occur. The temperatures for all eleven months at a selected location will be shown in 
the Information window. You can view the different temperature images by selecting different months in the pull-down 
menu on the 2007 Sea Surface Temps layer. Each month and year is represented by a three-letter month code followed 
by a two number year. For example, Apr07 SST shows the average SST data for April 2007.
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QUESTION 4: 
a.	 In which month are the coastal waters the warmest along the East Coast? 

b.	 In which month are the coastal waters the coldest along the East Coast? 

6. 	 Flip back and forth between the images for the coldest and warmest months by selecting each in the pull-down menu. 
Notice how far north the warm water moves on the East Coast. 

7. 	 Determine the geographic extent of the warm coastal waters (greater than or equal to 24° C) by moving your cursor 
over the northernmost location reached by warm water along the East Coast. The latitude and longitude of the cursor’s 
location is displayed below the legend. In My World, longitude is listed first, then latitude. It is conventional to record 
latitude first, and then longitude, and you should list them that way on your data sheet.

8. 	 Activate the U.S. States layer, and use the Get Information Tool to find the name of the state that warm water reaches 
at its northern most extent. 

QUESTION 5: 
a. 	 How far north did warm coastal waters (above 24° C) extend along the East Coast during the month of warmest waters 

in 2007? Give both the latitude and state name.

b. 	 How far north did warm coastal waters extend along the East Coast during the coldest month of 2007? Give both the 
latitude and the state name.

9. 	 Click and drag the Zoom In Tool to draw a rectangle of interest to include the East Coast of the United States. Click 
at one corner of where you want your rectangle to start on the map and drag out to create the rectangle area. Measure 
the shift in warm (above 24°C) coastal waters between the warmest and coldest months. First, click the Measurement 
Tool. Then click the northernmost extent of warm water. Then move your cursor in a southerly direction to draw a line to 
where the warm waters extend during the coldest month. Double-click to end the measurement line. The length of the 
line in kilometers will appear at the bottom of the My World window. (Note: You can change the measurement unit by 
selecting from the menu, Edit > Preferences…)

QUESTION 6: 
a. 	 How many kilometers do the warm coastal waters shift along the East Coast between warmest and coldest months? 

b. 	 How many miles is this? (1 kilometer = 0.62 miles)

10.	Next, study seasonal changes in water temperature along the West Coast. Use the Move Map Tool, to move the view 
to the West Coast. Using the same approach as you did for Question 4, examine each month’s image to determine the 
months of warmest and coldest waters along the West Coast.

QUESTION 7: 
a. 	 In which month are coastal waters the warmest along the Pacific Coast? 

b. 	 In which month are coastal waters coldest along this coast? 

Flip between the images for these two months, and notice how far south the cold water moves; it may help to zoom in to 
the boundary a little to see this better. 
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Ocean waters are continuously in motion. Waves and currents exchange and mix seawater, redistributing heat, nutrients, 
sediments, organisms, and pollutants across large and small distances. Near the ocean surface, currents are affected by 
wind, Earth’s rotation, and, in shallow areas, ocean floor bathymetry, or shape. Bathymetry is the study of the underwater 
depth of ocean and lake floors—the underwater equivalent of topography. 

Deeper in the ocean, water circulation is driven by differences in water density caused by temperature or salinity. These 
differences create invisible boundaries that separate a water mass—and its inhabitants—from another. A surface current 
is water moving within the upper 400 meters of the ocean. Surface currents make up about 10 percent of all the water 
motion in the ocean. The remaining 90 percent is made up of deep-water currents, which sink into the deep ocean basins 
at high latitudes where temperatures are low enough to cause the water’s density to increase. 

11.	Zoom out, using either Zoom to Previous Extents, or Zoom to Active Layer, so that you can see the waters off both coasts of 
the United States. 

Part II: Exploring Currents
IDENTIFYING THE WARM AND COLD CURRENTS
1. 	 Select the North American Currents layer by clicking the box to the right of this layer in the Layer List and activate it by 

clicking its name. Three currents appear as colored lines in your window. Find the names of the three surface currents 
shown in this layer by choosing the Get Information tool and clicking each current’s line. The name of the current will 
appear in an information window. The California Current and the Gulf Stream are both boundary currents that flow 
along the edge of a continent. Boundary currents separate coastal waters from oceanic waters. The Gulf Stream is one 
of the strongest surface currents on Earth. It is warm, deep, fast, and relatively salty. Compared to the Gulf Stream, the 
California Current is cool, broad, slow, and shallow. 

QUESTION 8: Compare the California Current and the Gulf Stream in terms of (a) their location, (b) direction of flow, and 
(c) water temperature. (Hint: Which current, if any, moves warm waters northward, and which, if any, moves cold waters 
southward?)

The uneven heating of Earth’s surface by the sun combined with the planet’s own rotation results in warm surface water 
being transported in a westward direction, first along and then away from the equator. The surface currents, bounded by the 
continents, follow a clockwise rotation pattern in the Northern Hemisphere and a counterclockwise rotation pattern in the 
Southern Hemisphere. These large, circular rotation patterns are called gyres.  

2. 	 Turn on and activate the North Atlantic Gyre layer. To see all of this gyre, use Zoom to Active Layer. The My World Data 
Library includes data showing all the surface currents. To view this layer select File > Import Add Data to Map, or click 
the button for Add Data to Map. Navigate through the data library for the Surface Currents layer and add it to your project. 
On this layer you can observe world surface currents: cool currents as blue, warm currents as red. You can see the 
approximate length of each current and, for some, the name by using the Get Information tool.
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Name___________________________________________	 Date_______________________________

How Warm Is the Ocean?
Use the Student Instructions pages to launch My World GIS and complete the activity. Fill in your 
answers on these pages.

Part I: Exploring Sea Surface Temperature

1.	Refer to the SST legend below the image. 
a. Which colors represent the warmest waters? _________________________________________________

	 _______________________________________________________________________________________ 

b. Which colors represent the coldest waters? __________________________________________________

	 _______________________________________________________________________________________

2.	How do water temperatures in the Pacific Ocean compare with those found in the Atlantic Ocean 
during 2007? _ _________________________________________________________________________

	 _______________________________________________________________________________________

	 _______________________________________________________________________________________

	 _______________________________________________________________________________________ 

3. 	The waters surrounding the island of Newfoundland, which lies off the eastern coast of Canada at 
a latitude of 50° N and a longitude of  55° W, appear deep blue in the SST images for the first few 
months of 2007. What does this mean? (Hint: Check the temperature with the Get Information tool. 
A temperature of 99° indicates that you’ve selected a point with missing data for that month.)

	 _______________________________________________________________________________________

	 _______________________________________________________________________________________

4.	Examine the seasonal changes in SSTs along the Atlantic coast of the United States during 2007 to 
see when the warmest and coldest temperatures occur.

a.	 In which month are the coastal waters the warmest along the East Coast?_______________________

	 _______________________________________________________________________________________

	 _______________________________________________________________________________________
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b. 	In which month are the coastal waters the coldest along the East Coast? ________________________

	 _______________________________________________________________________________________

5a. �How far north did warm coastal waters (above 24°C) extend along the East Coast during the month 
of warmest waters in 2007? Give both the latitude and state name.__________________________

	 _______________________________________________________________________________________

b. How far north did warm coastal waters extend along the East Coast during the coldest month of 
2007? Give both the latitude and the state name.____________________________________________

	 _______________________________________________________________________________________

	 _______________________________________________________________________________________

6a. �How many kilometers do the warm coastal waters shift along the East Coast between warmest and 
coldest months? _ ___________________________________________________________________

	 _______________________________________________________________________________________

b. How many miles is this? __________________________________________________________________

7.	Study seasonal changes in water temperature along the West Coast. 
a. In which month are coastal waters the warmest along the Pacific Coast? ________________________

	 _______________________________________________________________________________________

b. In which month are coastal waters coldest along this coast? ___________________________________

	 _______________________________________________________________________________________

Part II: Exploring Currents

8.	Compare the California Current and the Gulf Stream in terms of (a) their location, (b) direction of 
flow, and (c) water temperature. (Hint: Which current, if any, moves warm waters northward, and 
which, if any, moves cold waters southward?)________________________________________________

	 _______________________________________________________________________________________

	 _______________________________________________________________________________________
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Name___________________________________________	 Date_______________________________

How Warm Is the Ocean? Answer Key
Use the Student Instructions pages to launch My World GIS and complete the activity. Fill in your 
answers on these pages.

Part I: Exploring Sea Surface Temperature

1.	Refer to the SST legend below the image. 
a. Which colors represent the warmest waters? _________________________________________________

	 _______________________________________________________________________________________ 

b. Which colors represent the coldest waters? __________________________________________________

	 _______________________________________________________________________________________

2.	How do water temperatures in the Pacific Ocean compare with those found in the Atlantic Ocean

	 during 2007? _ _________________________________________________________________________

	 _______________________________________________________________________________________

	 _______________________________________________________________________________________

	 _______________________________________________________________________________________ 

3. 	The waters surrounding the island of Newfoundland, which lies off the eastern coast of Canada at 
a latitude of 50° N and a longitude of  55° W, appear deep blue in the SST images for the first few 
months of 2007. What does this mean? (Hint: Check the temperature with the Get Information tool. 
A temperature of 99° indicates that you’ve selected a point with missing data for that month.)

	 _______________________________________________________________________________________

	 _______________________________________________________________________________________

4.	Examine the seasonal changes in SSTs along the Atlantic coast of the United States during 2007 to 
see when the warmest and coldest temperatures occur.

a.	 In which month are the coastal waters the warmest along the East Coast?_______________________

	 _______________________________________________________________________________________

	 _______________________________________________________________________________________

Reds represent the warmest water temperatures. 

                                                              Deep blues represent the coldest water temperatures

However, the warmest waters seen in 2007 are colored orange.

                                                                                                         In August coastal waters 

were warmest along the East Coat in most locations; September waters were warmer in some 

locations.

The deep blue color of the waters surrounding Newfoundland in winter 2007 means that ice was 

present on the surface there, as temperatures were below 0° C.

                     In June 2007, most of the Atlantic Ocean seen in the SST layer was warm or

orange (temperatures greater than 24°C), while water temperatures in the Pacific Ocean were in

the colder blue to green range (between 14 and 22°C). That is, the Pacific Ocean was colder than

the Atlantic Ocean. 
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b. 	In which month are the coastal waters the coldest along the East Coast? ________________________

	 _______________________________________________________________________________________

5a. �How far north did warm coastal waters (above 24°C) extend along the East Coast during the month 
of warmest waters in 2007? Give both the latitude and state name._________________________

	 _______________________________________________________________________________________

b. How far north did warm coastal waters extend along the East Coast during the coldest month of 
2007? Give both the latitude and the state name.____________________________________________

	 _______________________________________________________________________________________

	 _______________________________________________________________________________________

6a. �How many kilometers do the warm coastal waters shift along the East Coast between warmest and

	 coldest months? ________________________________________________________________________

	 _______________________________________________________________________________________

b. How many miles is this? (1 kilometer = 0.62 miles) __________________________________________

7.	Study seasonal changes in water temperature along the West Coast. 
a. In which month are coastal waters the warmest along the Pacific Coast? ________________________

	 _______________________________________________________________________________________

b. In which month are coastal waters coldest along this coast? ___________________________________

	 _______________________________________________________________________________________

Part II: Exploring Currents

8.	Compare the California Current and the Gulf Stream in terms of (a) their location, (b) direction of 
flow, and (c) water temperature. (Hint: Which current, if any, moves warm waters northward, and 
which, if any, moves cold waters southward?)________________________________________________

	 _______________________________________________________________________________________

	 _______________________________________________________________________________________

                                                                                                   During 2007, warm  

coastal waters reached New Jersey beaches at a latitude of approximately 39° N.  

                                                                                                        Coastal waters along the 

West Coast are warmest during August or September. 

                                                                                      Coastal waters along the West Coast  

are coldest during March or April. 

                                                                  The California Current runs south along the West 

Coast, bringing cold water down from the north. The Gulf Stream runs north along the East Coast, 

bringing warm water up from the equator.

                                                                         During the coldest month of 2007, warm 

coastal waters extended to the central Florida coastline at a latitude of approximately 28° N. 

                         The warm coastal waters shift approximately 1,350 km along the East Coast 

between the warmest and the coldest months. 

840 miles  

                                                                                                       In March coastal waters 

were coldest along the East Coat in most locations; February waters were colder in some locations.


